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RESUMEN 

 

La presente investigación tiene como objetivo principal generar un 

algoritmo para determinar el Número de Curva en la Microcuenca Caplina, 

haciendo uso de un Sistema de Información Geográfico (SIG). La zona de 

estudio se tiene un área de 416.44 Km2 y corresponde a la subcuenca Media 01 

del río Caplina y la Quebrada Cotoñame. La metodología utilizada se basó 

principalmente en el procesamiento de imágenes satelitales Landsat sensor 

ETM+ y TM, con la finalidad de determinar la cobertura vegetal, tomando como 

referencia el algoritmo de Índice de Vegetación de Diferencia Normalizada NDVI, 

se realizó un análisis multitemporal, esto nos servirá para el análisis del Número 

de Curva (CN). 

Los resultados obtenidos en la investigación primero los parámetros 

geomorfológicos de la microcuenca nos indican que corresponde, el área de 

estudio es pequeña – intermedia, el perímetro este nos servirá para determinar 

el factor de forma de la cuenca, valores mayores a 1.20 corresponde a cuencas 

rodeando el desagüe, el coeficiente de compacidad, en zona de estudio tenemos 

un valor de 2.19, que corresponde a una cuenca rectangular. 

Palabras claves:  NDVI, número de curva, índice de vegetación, 

imágenes satelitales, cubierta vegetal, SIG 
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ABSTRACT 

 

The main objective of this research is to generate an algorithm to determine the 

Curve Number in the Caplina Micro-basin, using a Geographic Information 

System (GIS). The study area has an area of 416.44 km2 and corresponds to the 

Media 01 sub-basin of the Caplina River and the Quebrada Cotoñame. The 

methodology used was based mainly on the processing of satellite images 

Landsat sensor ETM + and TM, in order to determine the vegetation cover, taking 

as a reference the algorithm of the Normalized Difference Vegetation Index 

NDVI, a multitemporal analysis was carried out, this will help us for Curve 

Number (CN) analysis. 

 The results obtained in the investigation first, the geomorphological 

parameters of the micro-basin indicate that it corresponds, the study area is small 

- intermediate, the perimeter this will help us to determine the shape factor of the 

basin, values greater than 1.20 correspond to surrounding basins the drainage, 

the compactness coefficient, in the study area we have a value of 2.19, which 

corresponds to a rectangular basin.  

Keywords: NDVI, curve number, vegetation index, satellite images, 

vegetation cover, GIS 
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INTRODUCCION 

 

En una cuenca hidrográfica solo una porción de la precipitación general 

se convierte verdaderamente en escorrentía, una gran fracción de la 

precipitación se pierde por el contenido de infiltración de la superficie, por la 

evaporación a partir del área, también la transpiración de la vegetación, la 

conservación de la precipitación por los bosques, los charcos, etc; en 

acumulado, las sumas totales de las precipitaciones retenidas reciben el título de 

abstracciones. Las abstracciones en las cuencas hidrográficas, dado el valor de 

la saliente muestra es esencial establecer los usos de superficie y tipos de 

superficie de toda la cuenca hidrográfica, asignándolo un numero adimensional 

denominado Número de curva (CN) dependiendo del uso y tipo de superficie de 

las cuencas hidrográficas, siendo un parámetro muy sensible y determinante 

para la producción de la precipitación efectiva. (Yupanqui, 2016) 

En los últimos años en nuestro país se han registrado precipitaciones de 

gran intensidad que han ocasionado desbordes e inundaciones, que son riesgos 

naturales con las peores consecuencias, estos vuelven vulnerable a la 

comunidad ya que traen muchos problemas sociales. La ciudad de Tacna no es 

ajena a esta situación en el año 2020, se registraron precipitaciones máximas las 

cuales provocaron el colapso del desagüe y desborde de los ríos, en Tacna no 

contamos con antecedentes de uso de la Curva de Número (CN). 

La curva de número (CN) es una tecnología que con ayuda del (SIG) y 

desarrollo de la teledetección podemos procesar información satelital y generar 

la curva de número (CN), la cual nos brindara información y así prevenir 

fenómenos naturales. 

A nivel mundial, la técnica de la curva de número (CN) es uno de los más 

utilizados en el campo de la hidrología, ya que representa las características de 

suelo, vegetación y humedad de la microcuenca, con el desarrollo de la 

teledetección y (SIG), nos permite procesar imágenes satelitales con facilidad y 

en un menor tiempo. 
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CAPITULO I 

PLANTEAMIENTO DEL PROBLEMA 

 

2.1. Descripción del problema 

A nivel mundial las inundaciones son consideras los desastres naturales 

más importantes, causando muertes de hasta en 4 millones, estos casi siempre 

están relacionados con el cambio climático, aumento de temperatura y 

precipitaciones. 

En los últimos años en nuestro país se han registrado precipitaciones de 

gran intensidad, lo cual ha ocasionado eventos máximos de desborde e 

inundación. La ciudad de Tacna no es ajena a esta situación en el año 2020, se 

registraron precipitaciones máximas las cuales provocaron el colapso del 

sistema de alcantarillado y desborde de ríos, generando como resultado daños 

en la propiedad pública y privada, así mismo un impacto ambiental, social y 

económico en la población.  

La investigación se emplazada en la cuenca del río Caplina, debido a que 

esta ocupa un mayor porcentaje de la ciudad de Tacna, y es justamente el río en 

mención, este año se ubicó en un umbral hidrológico rojo, debido a las lluvias 

intensas, ocasionando daños cuantiosos en varios distritos de la ciudad, al 

generarse estos eventos se produce una mayor escorrentía que infiltración, 

favoreciendo al proceso erosivo, y por ende incrementa el proceso de 

inundación, es por ello la importancia de estudiar y caracterizar la Curva Número 

(CN), que es un parámetro hidrológico importante para determinar la escorrentía 

en una cuenca hidrográfica, debemos decir que la escorrentía es parte del ciclo 

hidrológico y es importante su estudio en el tema ambiental ya que permite 

predecir temas de sostenibilidad y degradación de los recursos naturales. 

Para poder caracterizar la Curva Numero (CN) de una cuenca es un 

proceso nada sencillo debido a que se debe considerar varios aspectos como 

características físicas del terreno, densidad y tipo de cobertura, la importancia de 

este trabajo nace de esta premisa, simplificar esta metodología en grandes áreas 

para economizar recursos, para ello usaremos un (SIG), nos permitirá producir  
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láminas de Curva Número (CN) en toda la cuenca, emplazando varios capas 

(suelo, vegetación, condiciones hidrológicas, etc.).   

Las consecuencias actuales de no contar con un mapa temático de Curva 

Número (CN), genera que no se puede determinar de forma exacta el 

escurrimiento superficial en la microcuenca del río Caplina, lo cual nos permite 

diseñar estructuras para poder prevenir los desastres naturales, también el 

aprovechamiento del recurso hídrico, determinar zonas de inundación y erosión. 

Con esta investigación se pretende generar un algoritmo el cual 

simplifique el proceso para determinar la Curva Número, utilizando los diferentes 

programas de (SIG), que nos permite generar láminas del (suelo, cobertura 

vegetal, precipitaciones, etc.), para luego integrarlos y obtener el mapa de Curva 

Número en la cuenca.  

También se pretende realizar mapas temáticos de suelo, cobertura 

vegetal, los cuales servirán como ayuda a otras especialidades en el estudio 

hidrológico e hidráulico de la cuenca. 

La Curva Número está relacionada directamente con la escorrentía 

superficial es por ello la importancia de determinar como la pendiente influye en 

este tema, por ello realizaremos un tipo de elevación digital, luego analizar la 

relación de la pendiente entre la Curva Número. 

Finalmente se pretende con el mapa temático de Curva Número, 

identificar posibles zonas de riesgo ambiental en toda la cuenca del río Caplina, 

siendo un gran aporte para otras investigaciones y para el tema de prevención 

de desastres en nuestra ciudad, así como en el ordenamiento territorial. 

2.2. Formulación del problema 

2.2.1.  Formulación general del problema 

 ¿Es posible determinar el Número de Curva en la Microcuenca Cuenca 

Caplina – Tacna, haciendo uso de un sistema de información 

geográfico? 
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2.2.2. Formulación específica del problema 

 ¿Cómo obtener las propiedades físicas de la microcuenca Caplina? 

 ¿Será posible relacionar la cobertura vegetal y uso de suelo con el CN? 

 ¿Tendrá alguna relación las zonas de peligro con el CN? 

2.3. Justificación e importancia de la investigación 

Metodológicamente se pretende generar un algoritmo el cual simplifique 

el proceso para determinar el Número de Curva (CN), utilizando el (SIG), lo que 

nos permite generar laminas del (suelo, cobertura vegetal, precipitaciones, etc.), 

para luego integrarlos y obtener el mapa de Curva Número en la microcuenca. 

Con esta investigación vamos a determinar con un mapa temático de 

Número de Curva (CN), la forma exacta en el escurrimiento superficial en la 

microcuenca del río Caplina, identificar posibles zonas de riesgo ambiental en 

toda la microcuenca del río Caplina, lo cual nos permite diseñar estructuras para 

poder prevenir desastres naturales y el aprovechamiento del recurso hídrico, 

determinar zonas de inundación y erosión. 

También con los mapas temáticos de suelo, cobertura vegetal, los cuales 

servirán como ayuda a otras especialidades en el estudio hidrológico e hidráulico 

de la microcuenca. 

2.4. Objetivos 

2.4.1. Objetivo General  

 Generar un algoritmo para determinar el Número de Curva en la 

Microcuenca Caplina Tacna, haciendo uso de Sistema de Información 

Geográfico. 

2.4.2. Objetivos específicos  

 Determinar los parámetros geomorfológicos de la microcuenca Caplina 

– Tacna 

 Determinar la relación entre la cobertura vegetal y uso de suelo con el 

Número de Curva. 

 Elaborar mapa temático de CN en la Cuenca Caplina - Tacna, e indicar 

posibles zonas de riesgo ambiental 
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2.4. Hipótesis  

2.5.1. Hipótesis General  

 H0: Es posible generar un algoritmo para determinar el CN en la 

Cuenca Caplina - Tacna 

2.5.2. Hipótesis Específica 

 H1: Se podrá determinar las propiedades físicas de la microcuenca 

Caplina. 

 H2: Existen una relación entre la cobertura vegetal, uso de suelo y la 

Curva Número. 

 H3: No existen una relación entre las zonas de peligro y el Número 

Curva 

2.5. Identificación y caracterización de variables 

Variables Indicadores 

Dependiente  

Número de Curva 

 
 
Valor para tipo de suelo y clasificación 
hidrológica  

Independiente 

- Cobertura Vegetal 

- Suelos 

- Parámetros físicos de la 

microcuenca 

 
 

- NDVI 
 

- Tipo de suelos 
 

- Área, perímetro, red hídrica, etc. 
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CAPITULO II 

MARCO TEORICO  

2.1. Antecedentes de la investigación 

Lavao y Corredor (2014), presentaron su informe de tesis titulado 

“Aplicación de la teoría del Número de Curva (CN) a una Cuenca de Montaña. 

Caso de estudio: Cuenca del río Murca, mediante la utilización de un Sistema de 

Información Geográfico”, tiene como objetivo principal proponer una aplicación 

de la teoría de la Curva Número en la cuenca del río Murca, para la obtención de 

la oferta hídrica en el rí0 Murca la cual es una subcuenca del río Negro. Para el 

desarrollo del estudio se utilizará de manera integrada los Sistemas de 

Información Geográfica (SIG), los cuales permiten trabajar con datos como lo 

son el tipo de suelo, precipitación y cobertura vegetal que se den en una misma 

localización geográfica. Finalmente el trabajo concluye en que una de las 

variables más importantes como lo es la cobertura terrestre fue identificado 

mediante imágenes Lansadt con la utilización de sistemas de información 

geográfica, esta metodología es mucho más rápida y económica. Tambien indica 

que es importante mencionar que la utilización de sistemas de información 

geográfica para la identificación del valor del Numero de Curva es un proceso 

rápido, especialmente si se tiene en cuenta que cada vez y a medida que 

avanza la tecnología la información es más fácil de adquirir. 

Argente (2014), en su informe de tesis titulado “Estudio de 

comportamiento hídrico de una cuenca hidrológica en Angola”, principal objetivo 

de este trabajo está centrado en la modelización hidrológica y comportamiento 

erosivo de una pequeña cuenca frente a las escorrentías generadas por la 

precipitación pluvial de una zona situada en el corazón del país de Angola. La 

metodologia utilizada fueron diferentes herramientas de análisis espacial, 

análisis hidrológico, interpolación y georreferenciación de imágenes que nos 

permite desarrollar el software especializado en gestión y análisis de información 

geográfica, el concluye indicando que mediante la realización de este proyecto 

se ha podido establecer los parámetros hídricos y geomorfológicos de una 

pequeña cuenca hidrológica cercana al Centro de Estudios Agronómicos de 

Chianga, obteniéndose parámetros útiles para el estudio de los cultivos 
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experimentales allí situados. A su vez, se deja abierta la puerta a profundizar 

sobre este estudio para obtener otros parámetros hidrológicos como la ecuación 

universal de pérdidas del suelo (USLE) que no se han podido desarrollar por 

carecer de datos experimentales de campo. 

Yupanqui (2016) elaboro el estudio ‘‘Obtención del Número de Curva a 

partir del Registro de Imágenes Obtenidas Mediante Percepción Remota’’ en la 

Universidad Nacional De San Cristóbal De Huamanga – Perú, este trabajo tiene 

como objetivo principal determinar el número de curva en cuencas hidrográficas 

a partir de registros obtenidos mediante percepción remota, con respecto a este 

objetivo desarrollo la metodología del procesamiento de imágenes satelitales 

Landsat 8, concluyendo en lo siguiente, se determinó el número de curva en una 

cuenca hidrográfica local a partir de registros obtenidos mediante percepción 

remota. El número de curva ponderado para la cuenca en estudio es de 77.6, 

también nos dice que el índice de vegetación en general varía desde -1 hasta 1, 

para la cuenca analizada y debido tipo de cobertura de usos de suelo existentes 

varía desde -0.214 hasta 0.4002, que corresponde a usos del suelo del tipo: 

agua o cubiertas artificiales -en un porcentaje ascendente a 4.32% de la 

superficie de la cuenca, suelo desnudo o vegetación muerta (25% de la 

superficie total de la cuenca), vegetación dispersa o poco vigorosa (68% de la 

superficie total de la cuenca) y vegetación Abundante y vigorosa (2% de la 

superficie total de la cuenca). 

Sotelo (2019), en su tesis denominada “Análisis de vulnerabilidad de 

riiesgo por cambio climático en la cuenca Caplina – Tacna”, tiene como objetivo 

principal fue realizar un análisis de vulnerabilidad de riesgo del cambio climático 

en la Cuenca Caplina – Tacna, la metodologia se baso en la identificación de 

peligros se ejecutó mediante el análisis de los diferentes factores y sus 

respectivas ponderaciones que influyen en su susceptibilidad (Social, Económica 

y Ambiental); para ello, se estudiaron los factores Geomorfológicos, 

Fisiográficos, Geológicos, Uso Actual del Suelos, Precipitación, Pendiente, 

Radiación Solar, Humedad Relativa, Temperatura y Cobertura Vegetal; todos 

estos fueron desarrollados a través de Sistemas de Información Geográfica 

(SIG). El análisis de la vulnerabilidad se efectuó a base de indicadores, 

establecidos en función a la exposición, fragilidad y resiliencia. Finalmente 
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concluye indicando que las áreas Vulnerables de la Cuenca, están 

representadas por los distritos a los que afectan en este caso son; por 

Vulnerabilidad Social en donde Tacna, Pachia posee vulnerabilidad alta en 

cuanto a la Vulnerabilidad Económica, Pachia y la Vulnerabilidad Ambiental en 

Pachia. 

Córdova et al. (2017) elaboro el estudio ‘‘Determinación del parámetro 

hidrológico número de curva en la cuenca de la quebrada El Batán, usando 

sistemas de información geográfica y percepción remota’’ El autor concluye con 

lo siguiente: La modelación hidráulica de los Sistemas de Drenaje Urbano 

necesita gran cantidad de investigación base, del estudio de escurrimiento e 

infiltración. Con el fin de colocar de datos reales y reducir el grado de error en los 

resultados del ejemplo hidráulico, se desarrolló una búsqueda para establecer 

valores de escurrimiento superficial mediante la técnica número de curva, y 

(SIG), (PR) y (ES). Esta metodología fue desarrollada en la cuenca de la 

quebrada El Batán de la ciudad Quito-Ecuador. La tabla de (CN) se desarrolló a 

la mezcla de parámetros como son el uso de suelo, (CV) y grupos hidrológicos 

(GHS); y la pendiente del terreno. Para la producción de la tabla de usos y 

cobertura vegetal se utilizó imágenes Landsat, Rapideye y Ortofotos. En 

función de estudios previos del área urbana se generó la tabla GHS, mientras 

que para. Estos mapas generados fueron sometidos a procesos de 

reclasificación, rasterización, y mediante álgebra de mapas se obtuvo el mapa 

CN. 

Portuguez & Verano (2016) elaboro el estudio “Generación de mapa de 

número de curva con sistema de información geográfica” en la Universidad 

Nacional Agraria La Molina, Perú, este trabajo tiene como objetivo principal 

generación de mapas temáticos de Número de Curva para el ámbito del territorio 

peruano, este objetivo se desarrolló en la metodología con el instrumento de 

programación (SIG), el cual hace posible trabajar con láminas de cobertura 

vegetal, tipos de suelos y modelo de elevación digital (DEM), se desarrolló los 

procesamientos con reclasificación de mapas y diferentes tipos de geo 

procesamiento de la información, dándonos como resultado el raster de “Numero 

de curva” se obtuvo resultados los valores de número de curva para condiciones 

normales varían desde 25 hasta 100, para condiciones secas de 12 a 100 y para 



18 
 

condiciones húmedas de 43 a 100, son valores adimensionales. Estos 

parámetros muy importantes en estudios hidrológicos. 

Díaz y Mercado (2017) elaboro el estudio ‘‘Determinación del número de 

curva en la subcuenca de Betancí (Córdoba, Colombia) mediante teledetección y 

SIG’’ Universidad de Córdoba – Colombia. El autor concluye con lo siguiente: La 

posición de la escorrentía se puede caracterizar mediante una (CN), el cual 

brinda información con la ayuda de las imágenes espaciales de la superficie y su 

cobertura vegetal. Utilizaremos diferentes programas de acceso libre que es el 

(SIG), que ayudo a generar datos y determinar una (CN). Los resultados 

obtenidos en la subcuenca de Betancí, el pasto ocupa el 85% y el 83%, en el 

(CN) se determinó entre 81 y 86. Los suelos cuentan con una infiltración alta lo 

cual apoya a los procesos erosivos. 

Ferrer Julia et al. (1998) elaboro el estudio ‘‘Aportación de la 

teledetección para la determinación del parámetro hidrológico del número de 

curva’’ El autor concluye con lo siguiente: El (CN) es un método muy utilizado en 

España para calcular la infiltración de la superficie. La investigación cuenta con 

algunos problemas en la recolección de información ya que no está actualizada. 

Por eso hacen el uso de (SIG) para recaudar información y solucionar el 

problema. Para determinar la (CN) se eligieron seis cuencas para ver sus 

diferentes características.  

Manso (2010) elaboro el estudio ‘‘Adaptación de las tablas de curva de 

numero para las formaciones vegetales del Parque Nacional de la Caldera de 

Taburiente (Isla de la Palma, España)’’ El autor concluye con lo siguiente: El 

modelo de la curva de numero funciona para valorar la escorrentía superficial 

que genera una definida lluvia. Se realizará una (CN) con los siguientes datos, el 

tipo de suelos, cobertura vegetal y grupo hidrológico, con esta curva se 

determina la escorrentía con sus diferentes ecuaciones del modelo. Estas tablas 

están basadas de acuerdo con los datos de los Estados Unidos, se ajustará esta 

(CN) a esta investigación para las formaciones vegetales del Parque Nacional de 

la Caldera de Taburiente (Isla de la Palma, España). 

Fernández de Villarán (2006) elaboro el estudio ‘‘Mejora de los 

parámetros de cálculo del modelo del número de curva y su validación mediante 
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un modelo hidrológico distribuido’’ El autor concluye con lo siguiente: Esta 

investigación plantea una cadena de mejoras al método del número de curva 

para la evaluación de la metamorfosis de lluvia en escorrentía. Se incide en la 

mejora de la exactitud en la determinación del conjunto hidrológico de suelo y en 

la disminución de la ambigüedad en el establecimiento del historial de humedad 

del suelo. Para la determinación del conjunto hidrológico de suelo se ha acudido 

a las definiciones del organismo de referencia, habiéndose realizado una 

revisión y estudio profundos del modelo. Los métodos propuesto parte de la 

estimación de la conductividad hidráulica saturada de los horizontes del suelo 

que, combinada con la profundidad a la que se produce la mínima conductividad, 

da lugar a un índice continuo del conjunto hidrológico de suelo, que disminuye 

en gran mesura la probabilidad de error que presenta la actual determinación 

discreta. La producción de valores continuos del grupo hidrológico de suelo lleva 

a plantear la obtención de los números de curva de forma continua en vez de 

discreta, mediante la trasformación de las tablas actuales en familias de 

funciones dependientes del índice de grupo hidrológico de suelo. 

 

2.2. Bases teóricas. 

2.2.1. Ciclo hidrológico 

Carchi (2015). El ciclo del agua empieza con la evaporación de mares 

y la corteza terrestre que con el calor que produce el sol se hagan las nubes, el 

agua que regresa a la Tierra tiene diferentes estados 

como de lluvia, nieve o granizo. El porcentaje mayor regresa sobre los mares. 

Las diferentes precipitaciones vuelven poco a poco a los mares.  

Loera (2002), nos dice que existen tres tipos de cómo se desarrolla el 

ciclo del agua: la hidrosfera la cual contiene el agua en sus tres elementos, la 

litosfera que contiene todas las rocas y materia solida de la superficie, la 

atmosfera que contiene todo el aire de la tierra.  
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Figura 1 

Esquema general del ciclo hidrológico  

 

 

 

 

 

 

 

 

Fuente: Chow, Maidment, & Mays (1994) 

El ciclo del agua involucra una sucesión de traslado recirculatorio 

e indeterminado o estable, esta circulación estable del ciclo se debe 

fundamentalmente a dos causas: la primera, el sol que proporciona la energía 

para levantar el agua (evaporación); la segunda, la gravedad terrestre, que hace 

que el agua condensada descienda (precipitación y escurrimiento). (Campos 

Aranda, 1984) 

Del ciclo del agua se debe a dos motivos: tenemos como primer motivo 

que el sol produce calor para levantar el agua este proceso se llama 

evaporación; el segundo es que por la gravedad el agua baje y este proceso se 

llama precipitación y escurrimiento. 

Tenemos la ecuación 1 que es el balance hídrico que son los elementos 

del ciclo del agua (Gaspari et al., 2013) 

Ecuación 1 

Balance Hídrico  

𝑃 = 𝐸𝑇 + 𝑄 + ∆𝑆 + ∆𝐺        
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Donde: 

P: Precipitación 

ET: Evapotranspiración 

Q: Caudal de escorrentía 

ΔS: Cambio en el almacenamiento de agua en el suelo 

ΔG: Cambio en almacenamiento de aguas subterránea (freática) 

Como se observamos en la ecuación 1, el balance de agua hace una 

evaluación de lo que necesita el agua en la vegetación, alcanzando por las 

variables del ciclo. Hoy en día hay un mayor aumento en las técnicas para 

encontrar el balance hídrico. (Gaspari et al., 2013) 

2.2.2. Cuenca hidrográfica 

Villon Béjar (2002), indica que la cuenca hidrográfica es un sistema que 

está conformada por ríos o corrientes de agua en apreciación la zona es 

reducida ya que es donde las aguas de lluvia se juntan en un mismo sitio.  

 Subcuenca: Se le denomina subcuenca a los ríos secundarios que 

desaguan en el rio principal, todos los afluentes tienen 

correspondientemente su cuenca, y esta se llama subcuenca. 

(Carchi, 2015) 

 Microcuenca:  Carchi (2015), nos dice que la microcuenca es 

la concentración de pequeñas áreas de una subcuenca, de los ríos 

secundarios.  

 

a. Parámetros generales de una Cuenca Hidrográfica 

 Área de la cuenca (A) (km2): 

Verdugo (2017) define área de una cuenca por la superficie en el espacio 

determinado por el impulso horizontal, determinado por el termino de las 

aguas  

 Perímetro de una cuenca (P) (km): 
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El perímetro es la medida del borde que confina la zona de la cuenca, por 

el termino de las aguas. (Verdugo, 2017) 

 Longitud Axial (La) (km): 

Es el espacio presente entre la entrada del rio y el lugar más distante de 

la cuenca. (Gaspari et al., 2013) 

 Ancho promedio (Ap) (km): 

Es la conexión presente entre el espacio de la cuenca y la longitud a 

conseguir en kilómetros de la cuenca. (Gaspari et al., 2013) 

2.2.3. Morfometría de cuenca hidrográfica 

Los criterios morfométricos necesitan de la figura, del realce, 

la desembocadura, modelo y manejo de la superficie, con los siguientes 

se calcula el comportamiento de cuerpos de agua y probables alteraciones 

a relación de la moderación hidrológica. (Vásquez Rangel et al., 2014) 

Una cuenca tiene como trabajo la de compilador y las precipitaciones y 

cambiar a escurrimientos, dependiendo de acuerdo con las situaciones 

climáticas. A partir de este punto las cuencas se pueden clasificar por su forma, 

diferentes usos de suelo y cobertura vegetal. (Sarmiento, 1988) 

Actualmente, hay diferentes instrumentos tales como los (SIG) y poder 

determinar, calcular y visualizar las imágenes de los satelitales y permitir 

efectuar la determinación del espacio estacional de las siguientes propiedades 

morfométricas de las redes de drenaje y la cuenca. (Gaspari et al., 2013) 

2.2.4. Número de Curva (CN) 

El número de curva (CN) fue creado por el Servicio de Conservación de 

Recursos Naturales de EE.UU. (Natural Resources Conservation Service – 

NRCS), que primero se llamaban Servicio de Conservación de Suelos (Soil 

Conservation Service - SCS) para calcular las precipitaciones de la lluvia 

acumulada, los niveles de humedad, características de la cobertura vegetal y el 

empleo del suelo. (Lavao, 2014) 
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El número de curva es una técnica hidrológica que nos ayuda a encontrar 

el contenido de escorrentía de una cuenca y establece diferentes cualidades 

físicas de la zona como diferentes usos de las coberturas y densidad. Díaz y 

Mercado (2017) 

El método de la (CN) determina con las siguientes variables: Lavao 

(2014) 

 Se remplaza las precipitaciones de una fase de tiempo previamente 

seleccionado.  

 Se considera un vínculo con el área del suelo hídrico y la cobertura 

vegetal.  

 Se cuenta con antecedentes del estado de humedad, se fija una 

variable de la (CN) que simboliza la interrelación. 

Los valores de CN varían en una categoría de 0 a 100 en que el monto 

más bajo corresponde a zonas con buen contenido de infiltración por ende la 

escorrentía baja, al contrario, a los montos altos de CN que nos muestran zonas 

impermeables o suelos con baja contenido de infiltración por ende buen 

potencial de escurrimiento. (Córdova et al. 2017) 

2.2.5. Cobertura de Suelo o cubertura vegetal  

El entendimiento de la cobertura de la tierra es un movimiento básico un 

proceso sostenible de los recursos naturales, la preocupación de la 

biodiversidad, disminución de los impactos en el área y en el cambio climático. 

Gamarra (2017) 

La cobertura del suelo se relaciona a un modelo de cobertura que está 

situada en el ámbito terrestre, mientras tanto utilizar un conjunto de actividades 

que desarrolla los seres humanos en conexión con el modelo de cobertura, y 

está agrupado con los fines económicos y sociales. (Seingier et al., 2009) 

2.2.5.1. Tipos de Cobertura vegetal 

MINAM. (2015), Según el Ministerio del ambiente estos se pueden clasificar en: 

Figura 2  

Tipos de Cobertura Vegetal
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2.2.6.  Imágenes satelitales 

Las imágenes de los satélites son elaboradas gracias a sensores 

conectados en un satélite artificial por la radiación electromagnética que son 

producidas y luego traspasadas a 30 puntos terrestres para determinar, calcular 

y visualizar su contenido. Se encuentra varios tipos de imágenes de los 

satelitales, actualmente estas herramientas son utilizadas para mejorar la calidad 

de la imagen y así poder utilizarlas para diferentes beneficios; espionaje militar, 

el monitoreo del cambio climático, monitoreo de incendios e 

inundaciones, rastreo de huracanes. (Gonzaga, 2014) 

Una cualidad que poseen las imágenes de los satélites es que poseen 

información a dentro de los rangos específicos. 

Esta averiguación es registrada en diferentes canales o bandas 

espectrales. Para poder analizar las imágenes satelitales tenemos que hacer un 

ajuste a sus bandas y poder cambiar de colores para así observar los diferentes 

cambios en las imágenes. (Pérez, 2012) 

2.2.6.1.  Tipos de Imágenes Satelitales  

a. Imágenes Pancromáticas 

Estas imágenes son captadas con un sensor digital que nos ayuda a 

calcular la radiancia y reflectancia en una amplia porción del espectro 

electromagnético. Estos sensores son crecidamente modernos y se pueden 

observar en una escala de grises. Con las pancromáticas podemos ubicar, 

reconocer y calcular accidentes y objetos, pero solo por apariencia física, 

también elementos generados por la función del hombre. (Sánchez, 2012) 

b. Imágenes Multiespectrales 

Las imágenes multiespectrales se captan mediante un sensor digital que 

mide la reflectancia en muchas bandas. Es accesible incluso que dos series de 

detectores midan la energía en dos partes diferentes de la misma longitud de 

onda. Estos distintos valores de reflectancia se combinan para crear imágenes 

de color. Los satélites de teledetección multiespectrales de hoy en día miden la 

Reflectancia simultáneamente en un número de bandas distintas que pueden 
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ir de tres a catorce. Gracias a las imágenes multiespectrales se puede 

distinguir las rocas superficiales y el suelo por su composición y consolidación, 

delimitar terrenos pantanosos, es decir se alcanza un mayor detalle con 

las imágenes multiespectrales. (Sánchez, 2012) 

c. Imágenes Hiperespectrales 

 Cervantes (2014), las imágenes Hiperespectrales se refieren a un 

detector espectral que mide la reflectancia en muchas bandas, 

con continuidad cientos o miles. La teoría en lo que se apoya la detección 

hiperespectral es que el tamaño de la reflectancia en numerosas franjas 

estrechas del espectro permite descubrir características y 

diferencias enormemente sutiles entre los rasgos de la superficie, 

fundamentalmente en lo que se refiere a vegetación, suelo y rocas.  

2.2.7. Procesamiento de imágenes  

Sánchez (2012), nos dice que el procesamiento de imágenes satelitales 

engloba una serie de técnicas de manipulación numérica de datos contenidos en 

imágenes digitales. Este análisis requiere para su realización de un software y 

hardware adecuados, para mejorar, corregir, analizar y extraer la información 

que necesitas.  

a. Resolución Espectral 

Usualmente la extensión de longitud de onda de distinto frecuencias 

grabadas, se vincula con el número de frecuencias que graba la plataforma, 

básicamente es el número y ancho de bandas espectrales consignadas por un 

sensor, ya que mientras más angostas sean estas bandas más será 

su resolución espectral. (Marquez y Rojas, 2017) 

b. Resolución Espacial 

Marquez y Rojas (2017). Es la fina visibilidad completa de una imagen, 

mientras menos sea el área representada por cada píxel de una imagen digital, 

crecerá los detalles que se pueden recoger y de 

ese modo su resolución espacial aumentara.  
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c. Resolución Radiométrica 

Marquez y Rojas (2017), se refiere al número de niveles digitales que 

se utilizan para emitir informaciones recogidas por un sensor. Ya que, 

si agranda el número de niveles, agrandaran los detalles que se 

podrá emitir dichos datos.  

d. Resolución Temporal 

Es un tamaño de la frecuencia, en el que un satélite está competente 

para obtener imágenes de un punto definido, que se designa intervalo de 

revisita. Son de alta calidad temporal y son de gran importancia en el rastreo de 

eventos que varían en períodos respectivamente cortos, como un incendio, 

inundación, progreso de las cosechas y verificación del agua sí que esta se 

encuentra en el caso de contaminada, etc. (Marquez y Rojas, 2017) 

e. Correcciones geométricas  

El propósito de las correcciones geométricas es corregir las distorsiones 

introducidas por estos factores para que la imagen corregida 

pueda poseer la calidad geométrica de un mapa. (Saldaña, 2019) 

f. Correcciones radiométricas  

Saldaña (2019), la modificación consiste 

en transformar los valores digitales (ND valores crudos) de la imagen a 

magnitudes físicas de radiancia y reflectancia, anterior a la obtención de los 

índices de vegetación.  

g. Correcciones atmosféricas 

Se desarrollan a origen de que no todos los componentes se ven 

afectados de igual forma. El grosor de la atmósfera puede transformar y las 

nubes pueden afectar la percepción del sensor producto que no recibe la 

radiancia que ciertamente sale a partir de la superficie. (Saldaña, 2019) 

2.2.7.4. Clasificación  

Sánchez (2012), estas operaciones se utilizan 

para reconocer y ordenar los pixeles de la imagen. Los algoritmos 
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de clasificación digital utilizan la reflectancia de cada píxel en distintas longitudes 

de onda y un juicio estadístico para asignarlo a 

un género espectral (bosque, pasto, urbano, etc.). Existen varios procedimientos 

para la clasificación de imágenes, a continuación, se indicará las más comunes.  

a. Clasificación Supervisada  

El método supervisado en este proceso el usuario selecciona en 

la imagen zonas representativas del género de información que desea emplear 

en su clasificación (pasto, bosque, cultivo, etc.). Después el algoritmo de 

clasificación crea estadísticos para estas áreas y utiliza los resultados para 

ordenar el resto de la imagen. (Sánchez, 2012) 

b. Clasificación No Supervisada 

El método no supervisado en este proceso el algoritmo de clasificación 

decide a cuál clase de información (pasto, bosque, cultivo, etc.) asigna cada 

píxel. (Sánchez, 2012) 

2.3. Definición de Término 

2.3.1. Número de curva 

El número de curva es una técnica hidrológica que nos ayuda a encontrar 

el contenido de escorrentía de una cuenca y establece diferentes cualidades 

físicas de la zona como diferentes usos de las coberturas y densidad. (Díaz y 

Mercado, 2017) 

2.3.2. Escorrentía 

La escorrentía son recorridos que hace el agua hasta alcanzar a 

un cauce. La escorrentía puede ser superficial, subsuperficial y subterránea, los 

cuales frecuentemente interactúan entre sí. La escorrentía superficial se forma 

cuando todos los poros del terreno han sido saturados de agua mediante la 

infiltración, de manera que el agua empieza a correr por la acción de la 

gravedad hacia el cauce más cerca. El cuerpo de escorrentía superficial que se 

genere dependerá las características de la cuenca, como circunstancias 

climáticas, topográficas y de suelos. (Ramón, 2015) 
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2.3.3. Precipitaciones 

Las precipitaciones es el agua que cae a la superficie de la tierra, 

como resultado de la condensación, misma que cuando la temperatura de un 

conjunto de aire desciende bajo su punto de rocío, por lo que parte del vapor de 

agua inicia a condensarse en forma de gotas o en su defecto si la temperatura 

es menor a 0°C, se transforma en hielo rápidamente. Mediante núcleos de 

condensación, que son partículas higroscópicas, al final el agua, empiezan a 

aumentar de tamaño, incluso que por su peso precipitan. (Ramón, 2015) 

2.3.4. Inundación 

Anegamiento estacional de terrenos que no están generalmente cubiertos 

por el agua. Incluye las inundaciones ocasionadas por ríos, torrentes, de 

montaña, corrientes de agua y las inundaciones causadas por el mar en las 

zonas costeras, y puede descartar las inundaciones de las redes de 

alcantarillado. (Olcina, 2007) 

2.3.5. Percepción remota 

La percepción remota es la ciencia de obtener información sobre objetos 

lejanos fuera de hacer contacto físico con ellos, restringida a prevención de 

radiación electromagnética, incluyendo luz visible e infrarroja, al semejante las 

ondas de radio y calor. Tal definición involucrar que entre el área de la tierra y el 

sensor debe haber una interacción energética, ya sea por reflexión de la energía 

solar o de un haz energético artificial, o por emisión propia. (Villegas y Vega, 

2008) 

2.3.6. Cobertura del suelo  

La cobertura del suelo es un paso fundamental para la gestión 

sustentable de los recursos naturales, la conservación de la biodiversidad, 

mitigación de los impactos en las dinámicas territoriales y en el cambio climático. 

(Saldaña, 2019) 
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CAPÍTULO III 

MARCO METODOLÓGÍCO 

 

3.1. Tipo y diseño de la investigación  

El tipo de la investigación es descriptiva, esto implica observar y describir 

eventos y situaciones sin influir sobre él de ninguna manera.  

El diseño de la investigación documental, esto implica en la obtención de 

información o datos se realiza a partir de documentos. 

Esta investigación se basa en la microcuenca Caplina, en base al número 

de curva (CN), es por ello será de forma de redacción y análisis de resultados 

asociados a la hipótesis y justificación propuestos en la investigación. 

3.2. Acciones y actividades  

Las actividades las hemos dividido en dos fases: 

3.2.1. Fase preliminar  

En esta primera fase se procedió a investigar y buscar toda la referencia 

histórica de trabajos realizados en la zona de estudio y zonas aledañas, así 

como documentación referido al tema. 

3.2.2. Fase de procesamiento de información  

Se realizó las siguientes actividades: 

- Descarga de imágenes de los satélites LANDSAT, sensor TM y ETM+, 

a través de la página web: “earth explorer” (USGS). 

- Procesamiento de información y tratamiento de imágenes LANDSAT, 

mediante una utilización el uso de herramientas modernas. 

- Modelamiento con la aplicación de SIG y uso de software para poder 

generar laminas y poder analizarlas espacialmente, observar las 

diferencias de cada imagen y poder prepararlas para el modelo final de 

la investigación y calcular diferentes funciones como: reclasificación, 

conectividad entre elementos geográficos. 

- Análisis de la información procesada, redacción del informe final 
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3.3. Materiales y/o instrumentos 

Los materiales utilizados son las imágenes satelitales Landsat sensor TM 

y ETM+, modelo digital del terreno (curvas de nivel), información de tipo de suelo 

y cobertura vegetal. 

Los instrumentos utilizados fueron las herramientas de Arcmap y ENVI. 

3.4. Población y/o muestra de estudio  

La población corresponde a la cuenca Caplina y la muestra son las 

subcuencas ubicadas en la Microcuenca del río Caplina. 

La unidad de análisis es la vegetación y tipo de suelo de la microcuenca.

 Técnicas de procesamiento y análisis de datos  

3.4.1. Ubicación de la zona de estudio 

La cuenca del rio Caplina está ubicada en el sur del Perú, en la provincia 

y región de Tacna, comprende los distritos de Palca, Pachia, Calana, Pocollay, 

Ciudad Nueva, Alto de la Alianza, Gregorio Albarracín y Tacna. 

La microcuenca Caplina tiene un área de 416.44 Km2, corresponde a la 

subcuenca Media 01 del río Caplina y la Quebrada Cotañane, ubicada en el 

distrito de Pachia, se encuentra en los poblados de Caplina, Calientes, Dispersa 

(pachia), Ancoma, Toquela, Challaviento, Anquipiña, Chachacomani, Challata, 

Tocuco, Kovire y Ataspaca, como se muestra en la Figura 4. 

Geográficamente las coordenadas de ubicación son las que se muestran 

en la Tabla 1. 

Tabla 1  

Las coordenadas UTM de la zona de estudio 

COORDENADAS SUPERIOR COORDENADAS INFERIOR 

366864.409 421633.268 

8061913.071 7994179.603 

 

 

 



32 
 

Figura 3 
Mapa de ubicación de la zona de estudio 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 4  

Mapa de Centros Poblados 
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Para la delimitación de la microcuenca se utilizó la herramienta 

Hec_Geohms, la cual nos permite trabajar el procesamiento de la cuenca y 

generar el proyecto, se consideró esta microcuenca por los siguientes factores: 

1. Los centros poblados están ubicados en una zona de 

desprendimiento, según la base de datos de Ordenamiento territorial 

del Gobierno Regional de Tacna. 

2. Encontramos estaciones pluviométricas como: Calientes, Toquela. 

Palca y Talabaya, las cuales pertenecen al Servicio Nacional de 

Meteorología e Hidrología del Perú (SENAMHI). 

3. Se pueden ubicar estructuras como reservorios de agua, puentes, etc, 

esto considerando que es una zona de alta vulnerabilidad económica 

media-alta, según la base de datos de Ordenamiento territorial del 

Gobierno Regional de Tacna. 

3.4.2. Descarga de imágenes satelitales  

Seguimos la siguiente secuencia de pasos 

Paso 1: Ingresar a la página www.earthexplorer.usgs.gov para descargar 

las imágenes satelitales Landsat, se utilizó Path:002 / Row:072 

Paso 2: Activamos las siguientes opciones en “Data Sets”:  

(Data sets > Landsat > Lansat colletion 1 > Landsat 8 OLI/TIRS C1 level- 

1 / Landsat 7 ETM + C1 level- 1 / Landsat 4-5 TM C1 level- 1 / Landsat 1-

5 MSS C1 level- 1). 

(Data sets > Landsat > Lansat Legacy > TM Mosaics (1984-1997) / ETM 

+ Pan (1999-2003) / ETM + (1999-2003) / TM (1984-1997) / MSS 1-5 

(1972-1987)). 

Paso 3: Finalmente realiza la búsqueda de la imagen con la fecha a 

descargar. En la tabla 2, se muestra las fecha de adquisición, el tipo de 

Landast y el sensor en los dos periodos. 

 

 

http://www.earthexplorer.usgs.gov/
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Figura 5 

Descarga de Imágenes Satelitales  

 

 

 

 

 

 

 

 

Tabla 2 

Imágenes de los satelitales Landsat 5 y 7 

Periodo seco Periodo húmedo 

Fecha de 
adquisición 

Landsat Sensor Fecha de 
adquisición 

Landsat Sensor 

1995-08-31 5 TM 1995-04-09 5 TM 

2000-08-04 7 ETM 2000-04-14 7 ETM 

2005-08-26 5 TM 2005-03-19 5 TM 

2010-09-25 5 TM 2010-05-04 5 TM 

2014-08-27 7 ETM 2014-05-07 7 ETM 

2019-10-12 7 ETM 2019-05-21 7 ETM 

 

3.4.3. Preprocesamiento de la información 

Igual que en el item anterior se realizó una secuencia de pasos 

a. Paso 1. Se procedió a ordenar las bandas 

Se utilizo el programa ENVI v. 5.3, a través de la extensión (File > 

Open Imagen File), seleccionar las bandas del 1 al 7, en los Landsat 

4-7 las bandas 3 y 4 serán reemplazadas con las bandas calibradas.  
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Aparecerá la ventana la lista de las bandas que fueron seleccionadas, 

en la barra principal, realizar la siguiente extensión (File > Save File 

as > ENVI Standard). Se abre una ventana llamada “New File 

Builder”, seleccionaremos la opción ‘’Import File”, reordenamos de 

manera ascendente las bandas. Una vez ordenada las bandas, 

seleccionamos la opción “Choose”, donde elegimos la carpeta de 

salida y guardamos el archivo y seleccionar “Ok”, para tener una 

mejor visualización en la combinación de las bandas, 

seleccionaremos la opción “RGB Color”, donde aparecerán tres filas 

que pertenece a los colores primarios, en la primera fila (R) se 

escogerá con la opción “Banda 7”, en la segunda fila(G) con la opción 

“Banda 4” y la tercera fila(B) con la “Banda 2”, luego seleccionar en 

“Load RGB”, esperamos por unos segundos.  

Figura 6 

Secuencia para ordenar bandas 

 

 

 

 

 

 

 

 

b. Paso 2: Cortar imágenes satelitales 

Para cortar la imagen satelital en el área de estudio, se utilizo 

las siguientes coordenadas de corte: 

- Coordenada Superior: Este: 366864.409, Norte: 8061913.071 

- Coordenada Inferior: Este: 421633.268, Norte: 7994179.603                
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Para cortar la imagen se utilizó el programa ENVI v.5.3, debemos 

ingresar la siguiente extensión (File > Open Imagen File), se 

seleccionarán; la banda ordenada de una fecha adquirida, seleccionar 

la opción “RGB Color”, y realizar la combinación en color natural, para 

obtener una mejor visualización de la imagen se puede hacer uso de 

la opción “Pixel Locator”. Ingresamos la extensión (File > Save Fiel As 

> ENVI Standard) se abre una ventana donde se selecciona “Import 

File”, ubicamos la banda y seguir la extensión (Spatial Subset > Map) 

donde se adjunta los datos de las coordenadas superior e inferior. 

Figura 7 

Secuencia de corte de imágenes satelitales  

 

 

 

 

 

 

c. Paso 3: Exportar imagen satelital  

Para poder trabajar en Arcmap se debe exportar la imagen en 

formato TIFF/GEOTIFF, en la figura 9 se muestra el diagrama para 

exportar la imagen. 
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Figura 8  

Diagrama de exportar imagen satelital en Arcmap 

 

 

 

 

 

 

 

d. Paso 4: Descargar curvas de nivel 

El uso del programa Google Earth Pro permite crear un 

polígono en el área del departamento de Tacna. Seleccionamos la 

opción de Herramientas y opciones, activamos la proyección en UTM. 

Luego elegimos la carpeta de salida y guardamos el archivo con 

formato (kmz), utilizando el programa Global Mapper v. 20, podremos 

descargar curvas de nivel en la zona de estudio, activamos la opción 

“Select Data Source” e ingresamos la extensión (Worldwide data > 

SRTM Worldwide Elevation Data [1-arc-second Resolution, SRTM 

Plus V3]) y seleccionar conectar. Automáticamente se genera la curva 

de nivel, finalmente seleccionamos la opción “Exportar Líneas” luego 

elegimos la carpeta de salida y guardamos. 

e. Paso 5: Imagen triangular (TIN) 

Para crear el “TIN”, se utiliza las curvas de nivel de nuestra 

zona de trabajo para observar los datos de altura máxima y mínima. 

Utilizamos las herramientas de Arcmap, (Arctoolbox > 3D Analysis 

Tools > Data Management > Tin > Create TIN). 

 

EXPORTAR IMAGEN SATELITAL

Seleccionar la imágen satelital ya procesada.

(File > Open Imagen File > Save File As > 
TIFF/GEOTIFF)

Elegimos la carpeta de salida.
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Figura 9 
Lamina de Imagen triangular “TIN” 

 
 

 

  

 

 

 

 

 

 

 

f. Paso 6: Creación del Modelo de Elevación Digital (DEM)  

Para crear el Modelo de Elevación Digital (DEM), debemos 

convertir la imagen TIN a formato raster, para ello ingresamos a 

nuestra caja de herramientas (Arctoolbox > 3D analyst tools > 

Conversion > From Tin > Tin to Raster). Finalmente obtenemos el 

Modelo de Elevación digital. 

3.4.4. Parámetros morfométricos de cuenca 

Los parámetros morfométricos de la cuenca nos servirán para poder 

determinar las características de la cuenca, las cuales tienen una estrecha 

relación con el sistema hidrológico, es por ello se determinar la red de drenaje, lo 

cual nos permite ver el volumen y escurrimiento hasta la velocidad y dirección de 

flujo.  Se utilizó la herramienta Hidrology de Arcmap, lo primero es generar el Fill 

(relleno). Para crear una imagen Fill ingresamos a nuestra caja de herramientas 

(Arctoolbox > Spatial Analyst tools > Hidrology > Fill). 
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Figura 10 
Mapa de Fill (relleno) 

 

 

 

 

 

 

 

 

 

 

 

Luego debemos generar la dirección de flujo, ingresamos a la caja de 

herramientas (Arctoolbox > Spatial Analyst tools > Hidrology > Flow Direction). 
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Figura 11 
Mapa de Dirección de Flujo 

 

 

 

 

 

 

 

 

} 

 

Se procede a generar el flujo acumulado, (Arctoolbox > Spatial Analyst 

tools > Hidrology > Flow Acumulation). 

Figura 12  
Mapa de Flujo de acumulación  
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a. Longitud de flujo 

Nos permitirá determinar el cauce principal de la cuenca, utilizamos la 

caja de herramientas (Arctoolbox > Spatial Analyst tools > Hidrology > Flow 

Length). 

Figura 13 
Mapa de Longitud de flujo 

 

 

 

 

 

 

 

 

 

 

b. Orden de red hídrica 

La orden de la red hídrica nos indica la jerarquía de los cursos de agua, 

para trabajar usamos la siguiente secuencia (Arctoolbox > Spatial analyst tools > 

Map Algebra > Raster Calculator), utilizamos el Raster Calculator, ingresamos el 

siguiente algoritmo con(“log_acc”>=2,”log_acc”). 

Debemos unir los segmentos producidos (Arctoolbox > Spatial analyst 

tools > Hidrology > Stream Link). Tenemos que dar el orden de corrientes. 

Ingresamos a nuestra caja de herramientas (Arctoolbox > Spatial analyst tools > 

Hidrology > Stream Order). 
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Finalmente creamos el orden de corrientes como se muestra en la 

siguiente figura. 

Figura 14  
Mapa de red hídrica 

 

 

 

 

 

 

 

 

 

 

c. Curva hipsométrica 

La curva hipsométrica nos permitirá determinar las altitudes de la cuenca, 

identificando así el relieve, este indica el porcentaje de la cuenca que está por 

encima de la cota de altitud media. Para procesar esta información se de utilizar 

la herramienta (Insert > Data Frame), se reclasifica (Arctoolbox > Spatial analyst 

tools > Reclass > Reclassify > Classification > Numerical Precisión). 

d. Propiedades de superficie  

Se determinó el área, perímetro, coeficiente de compacidad, factor de 

forma y pendiente media de la cuenca, todas estas están relacionadas con la 

superficie de la cuenca. También se determinó el centroide en X y centroide en Y 

e. Pendiente 

Este parámetro es importe para determinar la superficie de la cuenca, en 

la caja de herramientas usamos (Arctoolbox > Spatial analyst tools > Surface > 
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Slope), se debe reclasifica (Arctoolbox > Spatial analyst tools > Reclass > 

Reclassify). 

f. Tiempo de concentración  

Este valor nos indica el tiempo que necesita una cuenca para poder 

escurrir hasta el punto de salida, se trabaja con la fórmula del servicio de 

carreteras de California. 

Ecuación 2  
Tiempo de concentración  

𝑡𝑐 =  (
0.87 ∗ 𝐿3

𝐻
)0.385 

Donde: 

L= Longitud más largo del cauce principal (Km) 

H = Diferencia entre las dos elevaciones extremas  

3.4.5. Índice Diferencial de Vegetación Normalizado (NDVI) 

Para determinar el NDVI se debe trabajar con las bandas 3 y 4, ya que 

como se indicó en la parte conceptual estas son la banda visible – rojo y la 

banda del infrarrojo cercano respectivamente, esto se realiza para los Landsat 

de sensor ETM+ y TM, primero debemos realizar la corrección atmosférica, 

realizar el cambio de número digital (ND) a radiancia, para ellos utilizamos la 

siguiente ecuación  

Ecuación 3  
Conversión de ND a Radiancia 

𝑳𝝀 =
𝑳𝑴𝑨𝑿𝝀 − 𝑳𝑴𝑰𝑵𝝀

𝑸𝑪𝑨𝑳𝑴𝑨𝑿 − 𝑸𝑪𝑨𝑳𝑴𝑰𝑵
∗ (𝑸𝑪𝑨𝑳 − 𝑸𝑪𝑨𝑳𝑴𝑰𝑵) + 𝑳𝑴𝑰𝑵𝝀 

 

Donde: 

 Lλ                = Radiancia espectral 

QCAL          = Cuantificar calibrar valor de píxel en Número Digitales (DN) 

LMAXλ        = Escala de radiancia espectral a QCALMAX en 

(Watts/(m2*sr*μm)) 
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LMINλ         = Escala de radiancia espectral a QCALMIN en 

(Watts/(m2*sr*μm)) 

QCALMIN   = Mínimo cuantificar calibrar valor de píxel (correspondiente a 

LMINλ) en DN 

QCALMAX  = Máximo cuantificar calibrar valor de pixel (correspondiente a 

LMAXλ) en DN = 255 

Luego se transformó de radiancia a reflectancia, para este procesamiento 

se utilizó la herramienta de ENVI (Basic Tools > Preprocesing > Data-Specific 

Utilities > Landsat TM > Landsat Calibration), calibrar, en “Calibration Type” 

seleccionaremos “Reflectancia”. 

Una vez realizado el cambio a reflectancia, recién podemos utilizar el 

algoritmo para determinar el Índice de Vegetación De Diferencia Normalizada 

(NDVI), utilizando la siguiente ecuación  

Ecuación 4 

Ecuación para determinar el NDVI 

𝑁𝐷𝑉𝐼 =
(𝑁𝐼𝑅 − 𝑅𝐸𝐷)

(𝑁𝐼𝑅 + 𝑅𝐸𝐷)
 

Donde: 

NDVI: índice de vegetación de diferencia normalizada. 

NIR: Banda del infrarrojo cercano 

RED: Banda del rojo. 

Reemplazando los datos en la ecuación 4 podemos tener la ecuación 5 

(Para el caso de la imagen Landsat 5 TM o Landsat 7 ETM+, se aplicará la 

misma fórmula) 

Ecuación 5 
Ecuacion para determinar NDVI en imágenes Landsat 
 

𝑁𝐷𝑉𝐼 =
(𝐵𝑎𝑛𝑑𝑎 4 − 𝐵𝑎𝑛𝑑𝑎 3)

(𝐵𝑎𝑛𝑑𝑎 4 + 𝐵𝑎𝑛𝑑𝑎 3)
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Figura 15 

Diagrama para crear el “NDVI 

 

Una vez generado el NDVI, se reclasifico los valores para poder 

determinar las zonas de vegetación sana, suelos y cuerpos de agua, en la tabla 

3 podemos visualizar la descripción de cada intervalo.  

Tabla 3 

Reclasificación de NDVI 

NDVI ATRIBUTO 

-1 - 0 Agua o cubiertas artificiales  

0 – 0.2 Suelos desnudos o vegetación muerta 

0.2 – 0.4 Vegetación dispersa o poco vigorosa 

0.4 – 0.6 Vegetación abundante y vigorosa 

0.6 - 1 Vegetación muy densa y vigorosa 

 

Paso 1:

insertar las bandas “B3” y “B4”

Paso 2: Ingresamos a nuestra caja de herramientas
(Arctoolbox > Spatial Analysis Tool > Map 
Algebra > Raster Calculator)

Paso 3: Ingresamos la ecuación (Float(B4 -
B3))/(Float(B4 + B3)), luego elegimos la carpeta de 
salida y guardamos como "NDVI"

Paso 4:

Una vez creado el "NDVI", procedemos a 
reclasificar
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Para determinar la relación existente entre NDVI y suelo se determinó el 

área superficial de cada intervalo.  

 Para reclasificar el raster “NDVI” ingresamos a la caja de herramientas 

(Arctoolbox > Spatial analyst tools > Reclass > Reclassify). Luego en 

Classification”, donde se abrirá una ventana en “Method” vamos a cambiar a 

“Equal Interval” (Intervalos de Igualdad), en “Classes” Finalmente hemos 

reclasificado en tres intervalos el “NDVI”. Se debe transformar el NDVI creado de 

formato ráster a polígono, utilizando la caja de herramientas (Arctoolbox > 

Conversión Tools > From Raster > Raster to Polygon). 

Para calibrar el modelo se utilizó el shapefile elaborado por el MINAM 

(2012) el cual desarrollo el Mapa de Cobertura Vegetal del Perú, la cual es una 

herramienta de gestión del patrimonio natural y a la vez de soporte en la 

implementación de la Política Nacional del Ambiente. 

También se utilizó la información procesada por Portuguez y Verano 

(2016), en el cual se asigna un valor a cada cobertura de vegetacion  

Tabla 4 
Reclasificación de la cobertura y uso 

Descripción de coberturas Código 

Cuerpos de agua 1 

Nevados 2 

Centros poblados 3 

Cultivos/Áreas intervenidas 4 

Matorral arbustivo abierto 5 

Pradera en zona de clima frio 6 
Sabana de árboles leñosos 7 

Sabana hidromorfica 8 

Selva lluviosa tropical  9 

Selva lluviosa tropical con bambúes  10 

Selva temporal de hojas anchas 11 

Selva hidrolítica 12 

Desierto en zona de clima árido 13 

Fuente: Maurtua y Zelada (2016) 
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3.4.6. Determinación de Número de Curva (CN) 

El Número de Curva, está en relación con la retención potencial máxima 

(S), como se muestra en la siguiente ecuación 

Ecuación 6 
Retención potencial máxima 

𝑆 =  
100

𝐶𝑁
− 10 

La ecuación 6 se aplica en condiciones húmedas normales (AMC II), pero 

si estamos trabajando en condiciones secas (AMC I) o en condiciones húmedad 

(AMC III). Sabemos que el Número de Curva (CN), ha sido procesado por el Soil 

Conservation Service, tiendo como base el tipo y uso de suelo. Estos se trabajan 

en cuatro grupos: 

- Grupo A: Arena profunda, suelos profundos depositados por el viento, 

limos agregados.  

- Grupo B: Suelos pocos profundos depositados por el viento, marga 

arenosa.  

- Grupo C: Margas arcillosas, margas arenosas poco profundas, suelos 

con bajo contenido orgánico y suelos con altos contenidos de arcilla. 

- Grupo D: Suelos que se expanden significativamente cuando se 

mojan, arcillas altamente plásticas y ciertos suelos salinos. 

Esta relación se puede visualizar en la siguiente tabla, Números de curva 

de escorrentía para usos selectos de tierra agrícola, suburbana y urbana 

(condiciones antecedentes de humedad II, Ia = 0.2s) 

Tabla 5  
Número de curva de escorrentía para usos selectos de tierras agrícolas, 
suburbana y urbana 

DESCRIPCION DEL USO DE LA TIERRA 
GRUPO HIDROLOGICO DEL 

SUELO 

A B C D 

Tierra cultivada: sin tratamientos de conservación                                                                        72 81 88 91 

                               con tratamiento de conservación          62 71 78 81 

Pastizales: condiciones pobres 68 79 86 89 
                    condiciones optimas  39 61 74 80 

Vegas de ríos: condiciones óptimas 30 58 71 78 
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Bosques: troncos delgados, cubierta pobre, sin hierbas,  45 66 77 83 

cubierta buena 25 55 70 77 

Áreas abiertas, césped, parques, campo de golf, 
cementerios, etc.  

        

Óptimas condiciones: cubierta de pasto en el 75% o 
más   

39 61 74 80 

Condiciones aceptables cubierta de pasto en el 50% al 
75% 

49 69 79 84 

Áreas comerciales de negocios (85% impermeables) 89 92 94 95 

Distritos Industriales (72% impermeables) 81 88 91 93 

Residencial:         

Tamaño promedio del lote                  Porcentaje 
pormedio impermeable 

        

1/8 acre o menos                                                            65 77 85 90 92 
1/4 acre                                                                           38 61 75 83 87 
1/3 acre                                                                           30 57 72 81 86 
1/2 acre                                                                           25 54 70 80 85 
1     acre                                                                           20 51 68 79 84 

Paqueadores pavimentados, techos, accesos, etc. 98 98 98 98 

Calles y carreteras:         
          Pavimentados con cunetas y alcantarillados 98 98 98 98 
          Grava  76 85 89 91 
          Tierra                                                                      72 82 87 89 

Fuente: Chow V. T. (1994) 

Para determinar el Número de Curva (CN), se utilizó la base de datos del 

estudio realizado por Portuguez y Verano (2016), denominado “Generación de 

mapa de número de curva con sistema de información geográfica”, en el cual se 

utiliza la descripción de suelo dado por la FAO y se identifica el grupo hidrológico 

de suelo propuesto por Chow y Ven (1994), quienes nos indican las 

caracteristicas de suelo asociados a la infiltración. 

a. En los suelos que el agua infiltra rápidamente, profundos y de textura 

gruesa (arena o arena-limosa), son excesivamente drenados. 

b. Los suelos que están muy húmedos tienen una capacidad de 

infiltración moderada, si la profundidad es media a profunda y la 

textura es franco-arenosa, franca, francoarcillosa o franco-limosa, son 

suelos bien o moderadamente drenados. 

c. En suelos muy húmedos la infiltración es lenta, la profundidad es 

menor a media y la textura es franco-arcillosa, francoarcillosa-limosa 

o arcillosa-arenosa. Suelos imperfectamente drenados. 
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d. Suelos húmedos la infiltración es muy lenta, en horizontes de arcilla 

pobremente drenados (se incluye suelos con nivel freatico 

permanentemente altos y de poco espesor). 

En la siguiente tabla se puede apreciar la descripción de suelo, la 

simbología y al grupo hidrológico al que pertenecen  

Tabla 6 

Grupo hidrológico según descripción del suelo. 

DESCRIPCION DE SUELOS SIMBOLOGIA 
GRUPO 

HIDROLOGICO 

Acrisol Háplico - Alisol Háplico - Lixisol Háplico 
ACh-ALh-LXh C 

Acrisol Háplico - Alisol Háplico - Luvisol Crómico 
ACh-ALh-LVh C 

Arenosol Háplico – Solonchak Háplico 
ARh-SCh A 

Cambisol dístrico – Acrisol háplico 
CMd-ACh C 

Cambisol dístrico – Acrisol háplico – Lixisol háplico 
CMd-ACh-LXh C 

Cambisol dístrico – Alisol háplico 
CMd-ALh C 

Cambisol dístrico – Nitisol háplico 
CMd-NTh C 

Cambisol éutrico – Phaeozem háplico 
CMe-PHh B 

Cambisol éutrico – Vertisol éutrico 
CMe-VRe C 

Fluvisol éutrico – Gleysol éutrico 
FLe-GLe B 

Fluvisol éutrico – Regosol éutrico 
FLe-RGe B 

Gleysol dístrico – Cambisol dístrico 
GLd-CMd B 

Gleysol dístrico – Histosol Fíbrico 
GLd-HSf D 

Gleysol dístrico – Lixisol háplico – Fluvisol dístrico 
GLd-LXh-FLd A 

Leptosol dístrico – Afloramiento lítico 
LPd-R B 

Leptosol dístrico – Andosol .mbrico – Afloramiento 
lítico LPd-ANu-R B 

Leptosol dístrico – Andosol vítrico 
LPd-ANz B 

Leptosol dístrico – Cambisol dístrico – Regosol 
dístrico LPd-CMd-RGd B 

Leptosol dístrico – Regosol dístrico – Afloramiento 
lítico LPd-RGd-R B 

Leptosol éutrico – Afloramiento lítico 
LPe-R B 

Leptosol éutrico – Cambisol éutrico 
LPe-CMe C 
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Leptosol éutrico – Cambisol éutrico – Regosol 
éutrico LPe-CMe-RGe B 

Leptosol éutrico – Kastanozem háplico - 
Afloramiento lítico LPe-KSh-R B 

Leptosol lítico – Afloramiento lítico 
LPq-R B 

Lixisol háplico – Gleysol dístrico 
LXh-GLd B 

Luvisol crómico – Cambisol éutrico 
LVx-CMe C 

Regosol dístrico - Afloramiento lítico 
RGd-R B 

Regosol dístrico – Cambisol dístrico 
RGd-CMd C 

Regosol éutrico – Andosol móllico 
RGe-ANm C 

Regosol éutrico – Calcisol háplico 
RGe-CLh C 

Regosol éutrico – Cambisol éutrico 
RGe-CMe C 

Solonchak háplico – Leptosol éutrico 
SCh-LPe A 

Fuente: (Maurtua & Zelada, 2016) 

En la siguiente tabla se muestra el valor de Número de Curva (CN), de 

acuerdo con el grupo hidrológico del suelo. 

 Tabla 7 

 Número de curva para distintas condiciones hidrológicas. 

USO DEL SUELO 
O COBERTURA 

SISTEMA DE 
LABOREO 

CONDICION 
HIDROLOGICA PARA 

INFILTRACION 

GRUPO 
HIDROLOGICO DEL 

SUELO 

A B C D 

Barbecho 
Líneas Mala 77 86 91 94 

Líneas Mala 72 81 88 91 

Cultivos en línea 

Líneas Buena 67 78 85 89 

En contorno Mala 70 79 84 88 

En contorno Buena 66 75 82 86 

En contorno/terrazas Mala 66 74 80 82 

En contorno/terrazas Buena 62 71 78 81 

Cultivos densos 

Líneas Mala 65 76 84 88 

Líneas Buena 63 75 83 87 

En contorno Mala 63 74 82 85 

En contorno Buena 61 73 81 84 

En contorno/terrazas Mala 61 72 79 82 

En contorno/terrazas Buena 59 70 78 81 

Forrajeras y 
leguminosas 
pasturas en 
rotación 

Líneas Mala 66 77 85 89 

Líneas Buena 58 72 81 85 

En contorno Mala 64 75 83 85 

En contorno Buena 55 69 78 83 

En contorno/terrazas Mala 63 73 80 83 
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En contorno/terrazas Buena 51 67 76 80 

Pastura natural 

 Mala 68 79 86 89 

 Regular 49 69 79 84 

 Buena 39 61 74 80 

En contorno Mala 47 67 81 88 

En contorno Regular 25 59 75 83 

En contorno Buena 6 35 70 79 

Praderas                                                                           
Bosques 

 Buena 30 58 71 78 

 Mala 45 66 77 83 

 Regular 36 60 73 79 

Fuente: (Chow et al., 1994) 

Con la combinación de las tablas anteriores se procesó la siguiente tabla, 

datos que nos servirán para generar el modelo del número de curva (CN) 

Tabla 8 

Valores de los grupos hidrológicos  

DESCRIPCIÓN DEL USO DEL SUELO 
GRUPO HIDROLOGICO 

A B C D 

Cuerpos de agua 100 100 100 100 

Nevados 98 98 98 98 

Centros poblados 77 85 90 92 

Cultivos / Áreas intervenidas 62 71 78 81 

Matorral arbustivo abierto 45 66 77 83 

Pradera en zona de clima frio 68 79 86 89 

Sabana de árboles leñosos 45 66 77 83 

Sabana hidromorfica 25 55 70 77 

Selva lluviosa tropical 25 55 70 77 

Selva lluviosa tropical con bambúes 25 55 70 77 

Selva temporalde hojas anchas 25 55 70 77 

Selva hidrolítica 39 61 74 80 

Desierto en zona de clima árido 72 81 88 91 

 

Fuente: (Maurtua & Zelada, 2016) 

Para generar el modelo debemos tener el DEM (Modelo de Elevación 

Digital) está en formato raster, una imagen que trabaja con pixeles que nos van a 

dar un valor determinado en cada píxel, nos determinar las propiedades de la 

superficie, como la visibilidad y el flujo de agua. Se obtiene cuando procesamos 

un “TIN” que es una imagen triangular. 

Para generar el número de curva utilizaremos la metodología del Servicio 

de Conservación de Recursos Naturales de EE.UU. (Natural Resources 

Conservation Service – NRCS), originalmente llamado Servicio de Conservación 



52 
 

de Suelos (Soil Conservation Service - SCS), el área donde se aplicará será en 

la microcuenca del río Caplina, para poder generar el Número de Curva (CN) se 

necesitarán los siguientes componentes: 

 Mapa de Cobertura Vegetal 

 Modelo de Elevación Digital – DEM  

 Mapa de Tipos de Suelo 

Para generar el Número de curva se utilizó la extensión HEC-GeoHMS 

(Utilily > Generate CNgrid), el algoritmo utilizado se muestra en el siguiente 

diagrama. 

Figura 16 

Diagrama del Geoprocesamiento  

 

 

 

 

 

 

 

 

Fuente: Portugués y Verano (2016) 
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CAPÍTULO IV 

RESULTADOS  

 

4.1. Parámetros morfométricos de la cuenca 

Como observamos en la tabla 9, se logró determinar las propiedades de 

superficie de la cuenca, tomando como referencia la clasificación de Campos 

(1992), el área de estudio es pequeña – intermedia.  

En cuanto al perímetro este nos servirá para determinar el factor de forma 

de la cuenca, según lo expresado por Pérez (1979), valores mayores a 1.20 

corresponde a cuencas rodeando el desagüe. 

Gaspari et al. (2012), nos indica que el Coeficiente de compacidad de una 

cuenca está relacionado con la forma de la cuenca, en nuestra zona de estudio 

tenemos un valor de 2.19, que corresponde a una cuenca rectangular. 

Tabla 9 
Propiedades de superficie de la cuenca 

 

Se determinó también las propiedades relacionadas con la altitud de la 

cuenca, teniendo una cota máxima de 5 499.22 y una cota mínima de 1 300, lo 

cual nos representa que es una cuenca muy accidentada. El valor de la altitud 

media de la cuenca nos indica el área por encima del 50% de la misma en este 

DESCRIPCIÓN UNIDAD VALOR 

Área km2 416.44 

Perímetro km 158.80 

Coeficiente de compacidad 
(Gravelius) 

 2.19 

Factor de forma  1.76 

Pendiente promedio de la cuenca % 32 
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caso el valor es de 3 609.66, lo mismo en la altitud media que es de 3 437.08. 

estos dados nos indica la topografía de la microcuenca. 

 

Tabla 10 
Propiedades relacionadas a la altitud de la cuenca. 

 

Se determino también las propiedades relacionadas con la red hídrica la 

longitud máxima del cauce principal es de 48 512.7 Km y la pendiente promedio 

de la red hídrica es de 2.32%, en cuanto al orden de red hídrica el orden más 

pequeño (1), nos indican la primera parte de la ramificación, la microcuenca 

Caplina presenta una ramificación de orden 4, esto quiere decir que tiene tres 

ramificaciones es una cuenca con un sistema de drenaje bien desarrollado y con 

condiciones de infiltración adecuados, así como una capacidad de retención 

mayor. 

Tabla 11 
Propiedades relacionadas a la red hídrica. 

DESCRIPCIÓN UNIDAD VALOR 

Longitud del curso principal km 48512.70 

Orden de la red hídrica und 4 

Longitud de la red hídrica km 236.15 

Pendiente promedio de la red hídrica % 2.32 

Pendiente del cauce principal m/km 0.09 

 

DESCRIPCIÓN UNIDAD VALOR 

X centroide m 793.29 

Y centroide m 16088.32 

Cota máxima msnm 5499.22 

Cota mínima msnm 1300.00 

Altitud media msnm 3609.66 

Altitud más frecuente msnm 3437.08 
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En los parámetros generados se tiene el tiempo de concentración que es 

uno de los parámetros más importantes para determinar la planificación del uso 

de suelo y en el área de gestión de recursos, podríamos decir que es el tiempo 

mínimo que demora en salir una gota de lluvia desde la parte alta de la cuenca 

hasta el punto de salida, para la microcuenca se tiene un tiempo de 9 861.85 

horas  

Tabla 12 
Parámetros generados 

 

4.2. Análisis de Índice de Vegetación Normalizado (NDVI) 

Para determinar el Índice Diferencial de Vegetación Normalizado (NDVI), 

se reclasifico en intervalos de igualdad y se determinó la superficie de 

descripción para los dos periodos. Teniendo como resultado para la superficie de 

cubiertas artificiales en el año 1995 es de 232.60 Km2 y para el año 2019 de 

413.15 Km2, esto en referencia al periodo seco y para el periodo húmedo se 

tiene una superficie de 215.50 Km2 y 411.75 Km2 para los años 1995 y 2019 

respectivamente como podemos observar en la tabla 13 y 14 no se cuenta con 

vegetación muy densa y vigorosa en la zona de estudio solo podemos encontrar 

vegetación dispersa o poco vigorosa con la superficie menor a 3 Km2, para los 

diferentes años en los dos periodos. 

Tabla 13  
Análisis de Índice de Vegetación Normalizado (Periodo Seco) 

NDVI Descripción Periodo Seco/Superficie 
(Km2) 

Año 1995 Año 2019 
  

-1 - 0 Agua o cubiertas artificiales  232.60 413.15 

0 – 0.2 Suelos desnudos o vegetación 
muerta 182.21 2.67 

0.2 – 0.4 Vegetación dispersa o poco 
vigorosa 1.51 0.52 

Parámetros Generados 

Tiempo de concentración horas 9861.85 

Pendiente del cauce principal m/Km 0.09 
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0.4 – 0.6 Vegetación abundante y vigorosa 0.08 0.11 

0.6 - 1 Vegetación muy densa y vigorosa -  

Tabla 14 
Análisis de Índice de Vegetación Normalizado (Periodo Húmedo) 

NDVI Descripción Periodo Húmedo / 
Superficie  

(Km2) 
Año 1995 Año 2019 

  

-1 - 0 Agua o cubiertas artificiales  215.50 411.75 

0 – 0.2 Suelos desnudos o vegetación 
muerta 197.25 3.14 

0.2 – 0.4 Vegetación dispersa o poco 
vigorosa 2.90 1.18 

0.4 – 0.6 Vegetación abundante y vigorosa 0.78 0.26 

0.6 - 1 Vegetación muy densa y vigorosa           - 

 

Entonces podemos decir que en la microcuenca del río Caplina lo que 

predomina son áreas de cubiertas artificial las cuales han ido incrementando en 

el tiempo y en el caso de vegetación se ha visto una perdida, haciendo el 

análisis de la cobertura vegetal. 

Figura 17  
Análisis correlacional del NDVI en función de coberturas  
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Figura 18  
Mapa de reclasificación de NDVI año 1995 (Periodo seco) 
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Figura 19  
Mapa de reclasificación de NDVI año 2019 (Periodo seco) 

 

Figura 20  
Mapa de reclasificación de NDVI año 1995 (Periodo húmedo) 
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Figura 21  
Mapa de reclasificación de NDVI año 2019 (Periodo húmedo) 
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Figura 22  
Clasificación de vegetación abundante y vigorosa (Periodo húmedo_2019) 

 

Figura 23  
Clasificación de vegetación dispersa o poca vigorosa (Periodo húmedo_2019) 
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Figura 24  
Clasificación Suelos desnudos o vegetación muerta (Periodo húmedo_2019) 

 

Figura 25  
Agua o cubiertas artificiales (Periodo húmedo_2019)  
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4.3. Determinación de Número de Curva (CN)  

El tipo de suelo de la zona de estudio corresponde a Leptosol districo – 

Afloramiento lítico, sabemos que Leptosol proviene del griego leptos que 

significa delgado, refiriéndose a materiales no consolidados o sueltos. Los suelos 

Leptosol districo, tienen una saturación menor a 50% que sobreyace sobre un 

afloramiento lítico esto quiere decir de dureza coherente o compacta, con menos 

de 10% de fracturas. 

Figura 26  

Mapa de suelo de la zona de estudio 

 

 

 

 

 

 

 

 

 

 

 

La tabla de atributo del shapefile se agrega el campo de tipo de suelo 

insertando la codificación tomada de la tabla 6. 

Figura 27  
Tabla de atributos de suelos 
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En el shp de NDVI también se insertó un campo de Landuse, que es el código 

de Reclasificación de la cobertura y uso, propuesto en la tabla 4. 

Figura 28  
Tabla de atributos de NDVI 

 

Con la herramienta Intersect unimos las dos tablas de atributos (suelos y 

NDVI), para proceder a determinar el Número de Curva, pero antes se debe 

agregar campo para agregar el grupo hidrológico, según lo indicado en la tabla 

5. 

Figura 29  
Tabla de atributos de suelos y NDVI 

 

Se genero la tabla para la clasificación de cobertura vegetal en función al 

grupo hidrológico. 

Figura 30  
Tabla de atributos de CNLookUp 

 

 

El raster de Fill nos indica que se tiene alturas de 5500 hasta 1300 msnm. 
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Figura 31  

Mapa de Fill 

 

Finalmente se procesó el Mapa de Número de Curva, como se muestra en la 

siguiente figura, se tiene valores de 0 hasta 100, lo cual nos indica las 

condiciones de permeabilidad y por ende la capacidad de generar escorrentía 

superficial. Podemos decir entonces que en condiciones de permeabilidad muy 

alta los valores se acercan a cero, mientras que en un suelo impermeable los 

valores se acercan a 100. 
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Figura 32  
Mapa de Número de Curva 

 

Relacionando la cobertura vegetal (NDVI), con el Número de Curva podemos 

decir  

- Aguas o cubiertas artificiales (-1 – 0), corresponde el valor de Número 

de Curva de 100, al ser un suelo impermeable la escorrentía 

superficial es alta lo que en hidrología se denomina escorrentía 

directa, con una superficie de 412.91 Km2 y 234.04 Km2, para los años 

2019 y 1995 respectivamente. 

- Suelos desnudos o vegetación muerta (0 – 0.2), corresponde el valor 

de Número de Curva de 77, se puede tener infiltración, pero esta es 

mínima la escorrentía es alta, se tiene una superficie de 0.52 y 1.52 

Km2, para los años 2019 y 1995 respectivamente. 
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- Vegetación dispersa o poco vigorosa (0.2 – 0.4), corresponde el valor 

de 58, al tener presencia de vegetación se puede dar el proceso de 

evapotranspiración, pero la infiltración es mínima, se tiene valores de 

2.67 y 183.34 Km2, para los años 2019 y 1995 respectivamente. 

- Vegetación abundante y vigorosa (0.4 – 0.6), corresponde el valor de 

0, al tener presencia de vegetación se puede dar el proceso de 

evapotranspiración, existe infiltración y retención, la escorrentía 

superficial disminuye se tiene valores de 0.11 y 0.08 Km2, para los 

años 2019 y 1995 respectivamente. 

Tabla 15  
Relación de NDVI y CN 

NDVI Descripción CN 

Área (Km2) 

2019 1995 

-1 - 0 Agua o cubiertas artificiales  100 412.91 234.04 

0 – 0.2 Suelos desnudos o vegetación muerta 77 0.52 1.52 

0.2 – 0.4 Vegetación dispersa o poco vigorosa 58 2.67 183.34 

0.4 – 0.6 Vegetación abundante y vigorosa 0 0.11 0.08 

0.6 - 1 Vegetación muy densa y vigorosa - - - 

 

4.4. Relación de Zonas de riesgo ambiental y CN 

En la zona de estudio utilizando la información de Ordenamiento 

Territorial del ZEE del gobierno regional de Tacna, se puede determinar que en 

la zona de estudio el peligro corresponde a desprendimientos, los cuales suelen 

darse por dos factores altas pendientes y suelos no consolidados. Como se 

puede apreciar en la zona de estudio más del 50% de la superficie se ve 

afectado por este tipo de peligro como se visualiza en la siguiente figura. 

Como ya se mencionó los suelos que predominan en la zona de estudio 

corresponde a material no consolidado y en cuanto a la pendiente mayores a 

45º. 
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Figura 33  
Mapa de peligro 

 

Superponiendo el mapa de Número de Curva podemos apreciar que en los 

valores cercamos a 0, lo cual corresponde a suelos permeables el 

desprendimiento no existe, pero todo lo contrario se da en zonas donde el 

Número de curva se acerca a 100, por ser suelos impermeables y no 

consolidados la exposición al peligro por desprendimiento es alto. 

Con esto podemos decir que la metodología propuesta en la presente 

investigación se acerca a valores asociados a los de campo. 
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Figura 34  
Mapa de peligro asociado al Número de Curva 
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CAPÍTULO V 

DISCUSIÓN 

 

1. En cuanto al primer objetivo planteado en la investigación: Generación de 

un algoritmo para determinar el Número de Curva en la Microcuenca 

Caplina Tacna, haciendo uso de Sistema de Información Geográfico. 

Lavao y Corredor (2014), presentaron su informe de tesis titulado 

“Aplicación de la teoría del Número de Curva (CN) a una Cuenca de 

Montaña. Caso de estudio: Cuenca del río Murca, mediante la utilización 

de un Sistema de Información Geográfico”, tiene como objetivo principal 

proponer una aplicación de la teoría de la Curva Número en la cuenca del 

río Murca, para la obtención de la oferta hídrica en el río Murca la cual es 

una subcuenca del río Negro, el concluye en que una de las variables 

más importantes como lo es la cobertura terrestre fue identificado 

mediante imágenes Lansadt con la utilización de sistemas de información 

geográfica, esta metodología es mucho más rápida y económica. 

Tambien indica que es importante mencionar que la utilización de 

sistemas de información geográfica para la identificación del valor del 

Numero de Curva es un proceso rápido, especialmente si se tiene en 

cuenta que cada vez y a medida que avanza la tecnología la información 

es más fácil de adquirir. 

En nuestra investigación se pudo determinar el mapa de Número 

de Curva, haciendo uso del Sistema de Información Geográfico, se 

generó el algoritmo primero haciendo uso de imágenes Landsat y luego el 

uso de herramientas que simplificaron el trabajo, como el uso de la 

extensión Hec-GeoHMS. 

 

2. En el objetivo específico planteado: Determinación de los parámetros 

geomorfológicos de la microcuenca Caplina – Tacna 

Argente (2014), en su informe de tesis titulado “Estudio de 

comportamiento hídrico de una cuenca hidrológica en Angola”, principal 
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objetivo de este trabajo está centrado en la modelización hidrológica y 

comportamiento erosivo de una pequeña cuenca frente a las escorrentías 

generadas por la precipitación pluvial de una zona situada en el corazón 

del país de Angola. el concluye indicando que mediante la realización de 

este proyecto se ha podido establecer los parámetros hídricos y 

geomorfológicos de una pequeña cuenca hidrológica cercana al Centro 

de Estudios Agronómicos de Chianga, obteniéndose parámetros útiles 

para el estudio de los cultivos experimentales allí situados. A su vez, se 

deja abierta la puerta a profundizar sobre este estudio para obtener otros 

parámetros hidrológicos como la ecuación universal de pérdidas del suelo 

(USLE) que no se han podido desarrollar por carecer de datos 

experimentales de campo. 

En nuestro estudio se pudo determinar los parametros 

geomorfologicos de la microcuenca, los cuales sirven como analisis para 

determinar las propiedades fisicas y caracteristicas relacionadas con la 

distribucion hidrica de la cuenca. 

3. Determinación de la relación entre la cobertura vegetal y uso de suelo 

con el Número de Curva. 

De acuerdo con la investigación realizada por Yupanqui (2016), 

denominada “Obtención del Número de Curva a partir de registro de 

imágenes satelitales mediante la percepción remota”, el cual tiene como 

objetivo principal determinar el número de curva en cuencas hidrográficas 

a partir de registros obtenidos mediante percepción remota, en la 

conclusión final indica que el índice de vegetación en general varía desde 

-1 hasta 1, para la cuenca analizada y debido tipo de cobertura de usos 

de suelo existentes varía desde -0.214 hasta 0.4002, que corresponde a 

usos del suelo del tipo: agua o cubiertas artificiales -en un porcentaje 

ascendente a 4.32% de la superficie de la cuenca, suelo desnudo o 

vegetación muerta (25% de la superficie total de la cuenca), vegetación 

dispersa o poco vigorosa (68% de la superficie total de la cuenca) y 

vegetación Abundante y vigorosa (2% de la superficie total de la cuenca).  
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- Para la investigación realizada se determinó que parte de la 

metodología para determinar el Número de Curva es determinar la 

cobertura vegetal (haciendo uso de imágenes satelitales para generar 

el NDVI), y el uso de suelos, se utilizó la clasificación de cobertura de 

suelo logrando encontrar los siguientes valores para la clasificación de 

Aguas o cubiertas artificiales (-1 – 0), se encontró una superficie de 

412.91 Km2 y 234.04 Km2, para los años 2019 y 1995 

respectivamente. En cuanto a Suelos desnudos o vegetación muerta 

(0 – 0.2), corresponde el valor de Número de Curva de 77, se tiene 

una superficie de 0.52 y 1.52 Km2, para los años 2019 y 1995 

respectivamente. Para Vegetación dispersa o poco vigorosa (0.2 – 

0.4), corresponde el valor de 58, se tiene valores de 2.67 y 183.34 

Km2, para los años 2019 y 1995 respectivamente. Y finalmente para 

Vegetación abundante y vigorosa (0.4 – 0.6), corresponde el valor de 

0, con una superficie de 0.11 y 0.08 Km2, para los años 2019 y 1995 

respectivamente. 

 

4. Elaboración de un mapa temático de CN en la Cuenca Caplina - Tacna, e 

indicar posibles zonas de riesgo ambiental 

Sotelo (2019), en su tesis denominada “Análisis de vulnerabilidad 

de riiesgo por cambio climático en la cuenca Caplina – Tacna”, tiene 

como objetivo principal fue realizar un análisis de vulnerabilidad de riesgo 

del cambio climático en la Cuenca Caplina – Tacna, concluye indicando 

que las áreas Vulnerables de la Cuenca, están representadas por los 

distritos a los que afectan en este caso son; por Vulnerabilidad Social en 

donde Tacna, Pachia posee vulnerabilidad alta en cuanto a la 

Vulnerabilidad Económica, Pachia y la Vulnerabilidad Ambiental en 

Pachia. 

La zona de estudio se ubica en el distrito de Pachia  y se ha 

logrado determinar que el peligro está asociado a desprendimiento .
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CONCLUSIONES 

 

 Se determinó los parámetros geomorfológicos de la microcuenca caplina el 

área de estudio es pequeña – intermedia, que su perímetro corresponde a 

cuencas rodeando el desagüe, nos indica que su forma de la cuenca es 

rectangular, es una cuenca con un sistema de drenaje bien desarrollado y 

con condiciones de infiltración adecuados, así como una capacidad de 

retención mayor. 

 En el NDVI podemos decir que en la microcuenca del río Caplina lo que 

predomina son áreas de cubiertas artificial las cuales han ido incrementando 

en el tiempo y en el caso de vegetación se ha visto una perdida, haciendo el 

análisis de la cobertura vegetal. 

 En el Mapa de Número de Curva, se tiene valores de 0 hasta 100, lo cual 

nos indica las condiciones de permeabilidad y por ende la capacidad de 

generar escorrentía superficial.  

 Se determinó la relación entre la cobertura vegetal y uso de suelo con el 

Número de Curva es: Aguas o cubiertas artificiales (-1 – 0), corresponde el 

valor de Número de Curva de 100, al ser un suelo impermeable la 

escorrentía superficial es alta lo que en hidrología se denomina escorrentía 

directa, suelos desnudos o vegetación muerta (0 – 0.2), corresponde el valor 

de Número de Curva de 77, se puede tener infiltración, pero esta es mínima 

la escorrentía es alta, vegetación dispersa o poco vigorosa (0.2 – 0.4), 

corresponde el valor de 58, al tener presencia de vegetación se puede dar el 

proceso de evapotranspiración, pero la infiltración es mínima, vegetación 

abundante y vigorosa (0.4 – 0.6), corresponde el valor de 0, al tener 

presencia de vegetación se puede dar el proceso de evapotranspiración, 

existe infiltración y retención, la escorrentía superficial disminuye.  

 Se obtuvo como promedio del número de curva el valor de 58 que 

corresponde al NDVI de vegetación dispersa o poco vigorosa (0.2 – 0.4), 

que al tener presencia de vegetación se puede dar el proceso de 

evapotranspiración, pero la infiltración es mínima. 

 Se determinó que en la zona de estudio el peligro corresponde a 

desprendimientos, los cuales suelen darse por dos factores altas pendientes 
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y suelos no consolidados. Como se puede apreciar en la zona de estudio 

más del 50% de la superficie se ve afectado por este tipo de peligro. 

 Esta investigación se desarrolla a base de la cobertura vegetal, fue 

calculada mediante imágenes Landsat 5 TM y 7 ETM+ con la utilización de 

SIG, el valor del CN es un proceso rápido y económico teniendo en cuenta 

que cada que evoluciona la tecnología la información es más fácil de 

obtener.  

 El NDVI de las imágenes Landsat 5 TM y 7 ETM+ procesadas en la 

investigación, permitieron determinar, calcular y visualizar la intensidad 

vegetal de las coberturas vegetales presentes en la zona de investigación 

por los el NDVI y observar si tienen diferencias para cada cobertura vegetal.  

 En Tacna realizando esta investigación podemos ver que hay disponibles 

tipos de información y gratuita por internet para poder acceder y aplicar esta 

técnica y ser empleada en otras cuencas del departamento. 

 Se puede realizar y aprovechar la capacidad de los otros sensores y obtener 

información del departamento ya que podrían obtener información 

actualizada y de mejor calidad y poder utilizarla y evitar más desastres 

naturales. 

 En Tacna no contamos con un ordenamiento territorial actualizado lo que 

traen daños a la comunidad este método de la curva de número se puede 

utilizar para obtener antecedentes de las zonas y prevenir los desastres 

naturales. 
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RECOMENDACIONES 

 

 Se debe crear carpetas de los datos descargados de la información para ser 

guardadas en orden, ser registrada y rotulada para que no exista error en los 

datos al momento de procesarla ya que esto sería perjudicial al momento de 

los resultados. 

 Debemos tener conocimiento de los datos obtenidos en el procesamiento de 

las imágenes satelitales, ya que al conocer los datos podemos interpretar y 

analizar mejor los resultados. Al momento de utilizar las imágenes satelitales 

debemos observar y descargar las imágenes con menos nubosidad en el 

área de estudio. 

 La información obtenida debe ser renovada cada año para observar los 

cambios en las diferentes coberturas para hacer proyecciones sobre el futuro 

en la Microcuenca del Caplina – Tacna. 

 En Tacna las entidades públicas locales y regionales deberían hacer 

proyectos elaboración de mapas de cobertura y aumentar los antecedentes 

para ser utilizadas en la planificación y ordenamiento territorial para 

diferentes clases de desarrollo que generarían bienestar en la comunidad. 

 Para futuras investigaciones se recomienda laborar con imágenes de mayor 

calidad permitiendo un análisis más exacto de la cobertura vegetal y 

determinar el uso de la tierra. 
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ANEXOS 

 

ANEXO N°1 

 

 

 

 

 

 

 

 

 

 

Paso 1 y 2: 

 

 

  

DESCARGA DE IMÁGENES SATELITALES 

Paso1: Ingresar a la página 

www.earthexplorer.usgs.gov 

Paso 2: Ingresar Path: 002 Row: 072 

Paso 3: Se configura las opciones de página, 

Landsat y sensor. 

Paso 4: Se realiza la búsqueda de la imagen con la 

fecha que se va a utilizar y guardar. 
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Paso 3: 

 

 

 

 

 

 

 

 

 

 

Paso 4:  
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ANEXO N°2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Global 

Mapper 

 

Paso 3: Exportar Imagen 

Satelital 
Formato TIFF/GEOTIFF 

PREPROCESAMIENTO DE LA 

INFORMACIÓN 

Paso 1: Ordenar Bandas 
Reordenamos de manera 

ascendente 

Paso 2: Cortar Imágenes 

Satelitales 

Coordenadas Inferior 

  

Coordenadas Superior 

  

Paso 4: Curvas de Nivel 

Ajuste y corte de curva de nivel 

  

Creación de Polígono 

  

Generación de Curva de nivel 

Envi 

Google 

Earth Pro 

Paso 5: Imagen 

triangular 
Curva de Nivel 

Paso 6: Modelo de 

Elevación Digital (DEM) 
Imagen Triangular 

ArcMap 
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Paso 1: 

 

 

 

 

 

 

 

 

 

 

Paso 2: 
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Paso 3: 

 

 

 

 

 

 

 

 

Paso 4: 
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Paso 5: 

 

 

 

 

 

 

 

 

 

 

Paso 6: 
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ANEXO N°3  

  

Paso 1: Fill 

PARAMETROS MORFOMETRICOS DE CUENCA 

Nos permiten determinar las características 

de cuenca  

Se utilizará el programa de ArcMap 

Relleno 

Paso 2: Dirección de Flujo 

Paso 3: Acumulación de 

Flujo 

Paso 4: Longitud de Flujo 

Paso 5: Orden de Red 

Hídrica 

Determinar el cauce 

principal de la cuenca 

Jerarquía de los cursos de 

agua 

Orden de corrientes 

Paso 6: Curva 

Hipsométrica 
Altitudes de la cuenca (Excel) 

Perímetro 

Área  

Coeficiente de Compacidad 

Factor de forma 

Paso 7: Propiedades de 

Superficie 

Pendiente de cauce principal 

Paso 9: Tiempo de 

Concentración 

Paso 8: Pendiente 
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Paso 1 y 2: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 3 y 4: 
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Paso 5: 

 

 

 

 

 

 

 

 

 

 

 

Paso 6: 
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Paso 7: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 8: 
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ANEXO N°4 

 

Paso 2: Corrección Atmosférica de 

Numero Digital a Radiancia 

INDICE DIFERENCIAL DE VEGETACION 

NORMALIZADO (NDVI) 

Nos permiten estimar la cantidad, calidad y desarrollo de la 

vegetación 

Paso 1: Banda 3 y Banda 4 

Paso 3: Radiancia a Reflectancia 

Ecuación para determinar el NDVI 

Reemplazar los datos para el caso de las 

imágenes satelitales Landsat 5 TM y 7 

ETM+ 

Paso 4: Algoritmo para determinar el (NDVI) en 

ArcMap, (Float(B4 - B3))/(Float(B4 + B3)). 
  

Paso 5: Reclasificación del 

(NDVI) (Tabla3) 

  

Una vez generado el NDVI 

vamos a reclasificar para 

determinar las zonas de 

vegetación sana y cuerpos de 

agua.  

Calibrar el modelo 

(Tabla4) 

Para imágenes satelitales 

Landsat 5 TM y 7 ETM+ 

 𝑵𝑫𝑽𝑰 =
(𝑵𝑰𝑹 − 𝑹𝑬𝑫)

(𝑵𝑰𝑹 + 𝑹𝑬𝑫)
 

  
𝑵𝑫𝑽𝑰 =

(𝑩𝒂𝒏𝒅𝒂 𝟒 − 𝑩𝒂𝒏𝒅𝒂 𝟑)

(𝑩𝒂𝒏𝒅𝒂 𝟒 + 𝑩𝒂𝒏𝒅𝒂 𝟑)
 

Se utilizó el shapefile 

elaborado por el (MINAM) el 

cual desarrollo el mapa de 

cobertura vegetal del Perú 

Es una herramienta de gestión 

de patrimonio natural 

Envi 
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Paso 1: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 3: 

 

 

 

 



91 
 

Paso 4:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 5:  
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ANEXOS N° 5 

 

 

  

Paso 2: En la tabla de atributos de shapefile agregamos el Tipo de 

Suelo (GH)  (Tabla 6) 

DETERMINAR EL NUMERO DE CURVA 

Paso 7: Utilizar la herramienta de HECgeoHMS para interpolar 

Paso 3: En la tabla de atributos agregamos el Landuse que es el valor 

de la regasificación de cobertura vegetal (Tabla 4) 

Paso 4: Se unen las tablas de suelos y NDVI (Tabla 5) 

 

Paso 1: Se observa en la tabla de atributos que tipo de suelo  

  

Paso 5: Se agrega campo de Grupo Hidrológico y darle valor de 

100 

NDVI MAPA DE SUELO  DEM 

  

Paso 6: Se crea la tabla de (CNLookUp) para reclasificar la cobertura 

vegetal en función al Grupo Hidrologico 

Paso 8: Mapa de Numero de Curva 
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Paso 1: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 2: 
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Paso 3: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 4: 
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Paso 5: 
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Paso 6: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Paso 7: 
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Paso 8: 
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ANEXO N° 6 

 

Fotografía N°1. Sistematización de la información contextual 

 

Fotografía N°2. Procesamiento de información  
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MATRIZ DE CONSISTENCIA 

Título 
“GENERACIÓN DE ALGORITMO PARA DETERMINACIÓN DE LA CURVA NÚMERO EN LA MICROCUENCA CAPLINA - 
TACNA, HACIENDO USO DE SISTEMA DE INFORMACIÓN GEOGRÁFICO” 

Problema General Objetivo General Hipótesis General Dimensión Variables Indicador Metodología 

¿Es posible determinar el 
Número de Curva en la 
Microcuenca Cuenca 
Caplina – Tacna, 
haciendo uso de un 
sistema de información 
geográfico? 

Generar un algoritmo 
para determinar la 
Curva Número en la 
Cuenca Caplina Tacna, 
haciendo uso de 
Sistema de Información 
Geográfico. 

H0: Es posible 
generar un algoritmo 
para determinar el 
CN en la Cuenca 
Caplina - Tacna 

Población  
Cuenca Caplina   

Dependiente  
Número de 
Curva 
 
  

 
Valor para tipo 
de suelo y 
clasificación 
hidrológica  
 
 
 
 
 
 
- NDVI 
 

- Tipo de suelos 
- Área, 
perímetro, red 
hídrica, etc. 

El tipo de la 
investigación es 
descriptiva 

Problemas Específicos Objetivos Específicos 
Hipótesis 
Específicas 

Muestra 
Las actividades las 
hemos dividido en tres 
fases: 

1. Fase preliminar. 
2. Fase de 

procesamiento de 
información  
2.1. Descarga de 

información. 
2.2. Preprocesamie

nto de 
información. 

2.3. Parámetros 
geomorfológico
s de la cuenca. 

2.4. NDVI 
2.5. CN 

 

¿Cómo obtener las 
propiedades físicas de la 
microcuenca Caplina? 

Determinar los 
parámetros 
geomorfológicos de la 
microcuenca Caplina - 
Tacna 

H1: Se podrá 
determinar las 
propiedades físicas 
de la microcuenca 
Caplina 

Corresponde a las 
subcuencas 
ubicadas en la 
Microcuenca del 
río Caplina. 

Independiente 
- Cobertura 

Vegetal 
- Suelos 
- Parámetros 

físicos de la 
microcuenca ¿Será posible relacionar 

la cobertura vegetal y uso 
de suelo con el CN? 

Determinar la relación 
entre la cobertura 
vegetal y uso de suelo 
con el Número de 
Curva 

H2: Existen una 
relación entre la 
cobertura vegetal, 
uso de suelo y la 
Curva Número 

¿Tendrá alguna relación 
las zonas de peligro con 
el CN? 

Elaborar mapa temático 
de CN en la Cuenca 
Caplina - Tacna, e 
indicar posibles zonas 
de riesgo ambiental. 

H3: No existen una 
relación entre las 
zonas de peligro y el 
Número Curva 

 

 


